


CATIA v5 
This tutorial textbook is an essential companion to using CATIA v5 to assist with computer-aided 
design. Using clear CAD examples, it demonstrates the various ways through which the potential of 
this versatile software can be used to aid engineers in 3D modelling.

Based on 20 years of teaching experience, the authors present methods of using CATIA v5 to 
model solid and surface parts, to perform parametric modelling and design of families of parts, 
reconstruction of surfaces, to create macros and to apply various tools and their options during 3D 
modelling. Importantly, this book will also help readers to discover multiple modelling solutions 
and approaches to solve common issues within design engineering. With a comprehensive approach, 
this book is suitable for both beginners and those with a good grasp of CATIA v5. Featuring an end 
chapter with questions and solutions for self-assessment, this book also includes 3D modelling prac-
tice problems, presented in the form of 2D engineering drawings of many 3D parts in both orthogo-
nal and isometric views. Using the knowledge gained through reading the book chapters, users 
will learn how to approach surfaces and solids as 3D models using CATIA v5. This book  provides 
detailed explanations, using clear figures, annotations and links to video tutorials.

It is an ideal companion for any student or engineer using CATIA v5 in industries including 
 automotive, naval, aerospace and design engineering.

Readers of this book should note that the length and distance dimensions are in millimeters and 
the angular dimensions are in degrees. All other parameters, such as radii, areas and volumes, also 
use the metric system.
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Preface
This book is a part of the series of CAD tutorial books that presents the basic and advanced char-
acteristics and working possibilities of modern computer-aided design software solution CATIA v5.

This tutorial book is intended to be not only used by students from faculties with a mechanical 
or industrial engineering profile but also by design engineers from various industries (automotive, 
aerospace, military, heavy machinery, medical technology, etc.) who need to work in this CAD 
environment. Whether they are beginners or have a good experience in using CATIA v5, reading 
all written tutorials will help them to understand, upgrade and improve their knowledge and then 
to apply proven 3D modelling methods, to get familiar with many new modelling operations and 
options, by going step by step through the solutions explained for 3D modelling problems and those 
proposed for practising.

Based on our 20-plus years of teaching experience, we structured and wrote this book focusing 
on hybrid 3D modelling of many interesting parts. Each tutorial is a challenge for the reader and 
gradually presents different 3D modelling techniques, carefully explained and accompanied by 
clear figures, with annotations for a better understanding of the context. Thus, we use numerous 
graphical representations, drawings, screenshots, dialog boxes, icons of the tools, etc. Text and fig-
ures support the reader in understanding the approach and highlight all important selections (geo-
metric elements or options). By presenting all phases of the modelling in a step-by-step manner, we 
explain a great number of options and strategies to model complex 3D surfaces, parametric solids 
and family tables, macros and Visual Basic Application (VBA) scripts.

All explanations and the collection of 3D examples included at the end of this book, in all their 
diversity, have been carefully selected to cover additional options, and some of them are followed 
by video tutorials presented in the Annexes, and near most of the proposed 2D drawings. Although 
many theoretical aspects are briefly explained to solve the 3D modelling problems easily, this book 
does not present all available commands and their options. Therefore, the reader is encouraged to 
further explore important sub-options encountered in the dialog boxes and then to search for some 
new modelling solutions for solving challenging parts.

To test the reader’s knowledge, the last chapter of this book contains 75 tests with their detailed 
answers, a scoring system (for self-assessment) and many 3D modelling problems for self- practising. 
Through the individual study, the reader is invited to model them in 3D because each part has an 
educational scope and they have different degrees of complexity, shapes and functionalities.

From students to engineers, all are advised to open and follow the pages of this book with con-
cern and perseverance, to patiently go through all the stages of the presented tutorials, to explore 
the proposed 3D models and then to successfully apply the knowledge acquired in their professional 
activity.

The authors have made a consistent effort and passionately created all the written and video 
tutorials presented in this book, with great attention to detail. Several people, experts in other CAD 
programs, helped us create the content of this book. Our families, friends and colleagues from 
the university and industry supported us with patience and interest, and they proposed ideas and 
 provided valuable observations, and we thank them for their time and feedback. The publisher 
(Taylor & Francis/CRC Press) also guided us with interest and professionalism to create a manu-
script that will provide a great experience to our readers.

We hope that this book, by its content, will rise to the level of exigency that we set ourselves 
from the beginning and will be useful to all those who will have the curiosity and need to open it 
and learn from our knowledge.

We also challenge readers to send us other solutions for the presented 3D modelling problems 
and links to their own video tutorials and to contribute with their ideas and suggestions to improv-
ing the content of the future editions of this book.
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1

1 Introduction

1.1  COMPUTER-AIDED DESIGN IN CONCEPTION AND 
DEVELOPMENT OF INDUSTRIAL PRODUCTS

Computer-aided design (CAD) is increasingly used in a wide variety of engineering fields, and it is 
evolving rapidly. This concerns both the general architecture and the addition of new functions and 
modelling tools in existing CAD programs, as well as their capability to create a geometry of high 
complexity, parametrically designed, based on the specifications imposed by the client, also allow-
ing FEA simulations or machining on NC machine tools.

The ever-increasing complexity of products leads to some difficulties in the design and then in 
the manufacturing stages. The design engineer must be aware of advanced working methods, and 
in his work, he tries several possible variants and solutions and then optimizes the one identified as 
correct following the successful modelling procedure by implementing CAD and simulation tools. 
He also takes decisions related to shape, material properties and manufacturing technologies, based 
on the information taken from CAD handbooks, standards, databases, numerical analysis, the expe-
rience of the company and his intuition and knowledge. Finally, his activity leads to the validation 
of the projects and their transformation into successful products.

Thus, in general terms, the modern computer-aided design can be defined as the process of inte-
grating a set of functional specifications and requirements into a complete virtual representation of 
the physical product or system that best meets those requirements and specifications.

The evolution of CAD systems has shortened the product lifecycle, increased their complexity 
and performance, and stimulated competition for new reliable products at attractive prices. The 
competition also means new jobs and opportunities for design engineers.

Companies are looking for specialists who are able to work with modern CAD systems, to make 
complex numerical programs and scripts and to use libraries with algebraic calculation methods 
and statistics, and who have a true vision in creating complex surfaces, which meet requirements in 
almost all current products. Other specialists perform specific calculations and kinematic simula-
tions, determine moments of inertia, simulate mechanical processing on machine tools equipped 
with numerical control, etc.

Not only the design and development activities, but also the cost related to the design changes 
are intensifying as the project advances towards the launch in series production and then on the 
market, being much lower in the design phases when the decisions are made to establish the opti-
mal solution.

1.2  GENERAL ASPECTS REGARDING THE USE OF 
CATIA v5 PROGRAM WORKBENCHES

CATIA (computer-aided three-dimensional interactive application), a product of Dassault 
Systèmes, is currently one of the most widely used integrated CAD/CAM/CAE systems worldwide, 
with applications in various fields, including machine manufacturing industry, aeronautics, naval 
industry, automotive industry, robotics, agricultural machinery and equipment, chemical industry, 
food industry and consumer goods. The 5th version has been available since 1999, with each new 
release introducing new workbenches and additional functionalities, in parallel with the improve-
ment of the existing ones.

CATIA v5 provides a wide variety of solutions to meet all design and manufacturing issues. 
Among its many functionalities, advanced design of mechanical parts, interactive creation of 

DOI: 10.1201/9781003281153-1



2 CATIA v5 Advanced Parametric and Hybrid 3D Design

assemblies, faster 2D and assembly drawings, the ability to design in a parameterized manner, 
generation of complex surfaces, performing finite element analyses and simulation mechanical pro-
cessing can be mentioned.

All these functionalities are possible due to the fact that the program uses virtual models, defined 
as the set of computer data necessary to manipulate an object created on a computer, in the same 
way as a real object. It is possible, thus, to test it under various mechanical and thermal stresses and 
their dynamic behaviour, to check whether or not an assembly is correct with all its constraints, to 
ensure that the moving of components, one against the other, does not generate collisions, etc.

CATIA v5 has a modular structure, which ensures great versatility and transition from one work-
bench to another, with the possibility of continuous editing of the project in progress. Although the 
number of workbenches implemented in the program is very large, some of them can be considered 
as principal, as the following ones:

• CATIA Sketcher – creates the sketch of a two-dimensional profile, being a starting point in 
the process of obtaining a three-dimensional feature.

• CATIA Part Design – is used for the three-dimensional design of parts. This workbench, 
along with Sketcher, may be considered as core workbenches of the CATIA v5 program.

• CATIA Assembly Design – allows the generation of an assembly of parts using various 
mechanical constraints for their positioning and establishing contact between surfaces. 
As a scalable workbench, Assembly Design can be cooperatively used with other current 
companion products such as Part Design and Generative Drafting.

• CATIA Drafting – contains the necessary tools to obtain 2D drawings of the created parts 
and assemblies.

• CATIA Knowledge Advisor – is very useful in all the design stages and parameterized 
management of parts and assemblies, and also in the automation of certain processes of 
analysis with finite elements, simulation of processing on NC equipment, etc.

• CATIA DMU Kinematics – creates complex movement simulations based on kinematic 
couplings established between components of assemblies.

• CATIA Generative Sheetmetal Design – is used to model sheet metal parts, processed by 
cold plastic deformation. The user has the opportunity to obtain 2D drawings and their 
unfolding views.

• CATIA Generative Structural Analysis – is a powerful environment to perform analyses 
with finite elements, applied to parts and assemblies, in order to determine their behaviour 
under defined conditions of static or dynamic loading.

• CATIA Generative Shape Design – has applicability in creating objects that have complex 
surfaces and are difficult to design in other workbenches.

• CATIA Prismatic Machining – serves to simulate mechanical processing on machine tools 
equipped with NC devices.
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FIGURE 2.1 The program interface in the Part Design workbench.

FIGURE 2.2 Accessing the Generative Shape Design workbench.

FIGURE 2.3 Different types of files opened by the user.
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In the example in Figure 2.4, the Window menu is also presented, which helps the user to select 
which of the two open documents will become current, receiving, by selection, a check mark next 
to the name. At the moment, even if the user has opened multiple documents (with the same or dif-
ferent extensions), he can work only on one document, for example, to model, edit, or view a 3D 
model of a part. It is always possible to access another document/file, for example a 2D drawing of 
the current 3D model to insert the required dimensions.

The same figure shows the names of two different documents, the model of a part (with CATPart 
extension) and its 2D drawing/drafting (CATDrawing) because the user needs both files to open. 
The transition between documents is simple and fast, and the connection between them is also estab-
lished by the program. This principle is called external association between different workbenches.

The menu bar (File, Edit, View, Insert, Tools, Window and Help) is basically a standard for 
Microsoft Windows compatible programs and contains CATIA-specific options. These differ 
depending on the workbench used, and some that are more important will be presented below, and 
others are used and explained in detail in the tutorials in Chapter 3.

For instance, the File menu contains options for saving and opening files. Selecting the New option 
leads to a selection box with the same name in which the program’s file types are presented in a list. 
Choosing a type leads to the opening of a workbench; for example, in the case of Figure 2.5, follow-
ing the Part selection, the CATIA Part Design workbench will open. Note also the Save Management 
option, which is used to save some files to different locations. The dialog box in Figure 2.6 also shows 
a preview of the saved entity, in this case, a part and its 2D drawing. It shows the names of the files, 
where they will be saved, their status, the user’s rights over the respective location, etc.

FIGURE 2.4 Opening the Window menu to choose what file will become current.

FIGURE 2.5 List of various types of files.
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The Close, Open, Save, Print, Document Properties and Exit options are well known because 
they are part of any menu of a modern program in various operating systems. The Desk option, 
however, is specific to some CAD programs and shows, according to Figure 2.7, the links estab-
lished between an assembly (CATProduct) and its components (CATPart). Also, right-clicking on 
a component and choosing the Open command has the effect of opening the document containing 
that component. The representation in the figure is particularly suggestive.

The Edit menu contains the well-known Undo, Repeat, Cut, Copy, Paste, etc. options. This menu 
also includes Delete (for deleting, for example, a component from an assembly) and Update (for 
updating geometrical and dimensional constraints, components’ positions in the assembly, or 2D 
drawings after changing some dimensions of the 3D model of a part or belonging sketches, etc.).

The Component Constraints option involves selecting a component of an assembly and high-
lighting all assembly constraints in which that component is involved.

For example, Figure 2.8 shows the components of an assembly model and the list of their applied 
constraints. Three of them are selected, and the name of the component is observed in the name of 
each constraint.

Choosing the Links option displays the dialog box in Figure 2.9. A window with a list of compo-
nents of the assembly is displayed, and the user has the possibility to select one of its parts to replace 
(pressing the Replace button) with another part.

In the selection box on the right, Browse, two buttons are available, as follows: File allows user 
to load a file, by default a component, from a storage medium, to replace the current selection, and 
Loaded document specifies a component already loaded and accessible from the Window menu.  
Of course, the replacement of a component must be possible and logical, and the assembly con-
straints are taken from the previous component to the one that replaces it.

FIGURE 2.6 The management window for saving files.

FIGURE 2.7 Tree-like structure of an assembly.
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This method is applicable to assemblies containing parts for which several variants have been 
created. These variants are, usually, composed of different shapes of the same part(s), newer revi-
sions of the same part(s) or a totally new constructive solution. Thus, different constructive solutions 
can be tested for the respective variants of assemblies.

It can be, also, observed, the link between the components’ names in the specification trees and 
their files, previously saved with a certain name, and also the type or status of the links (fields Link 
type and Status).

The Properties option is used to display and edit useful information regarding a CATIA object; 
it may be an individual 3D model, a component of an assembly, a 2D drawing or a finite element 
analysis.

FIGURE 2.8 Structure of an assembly model with constraints applied between components.

FIGURE 2.9 Replacement of components from an assembly by loading other available parts.
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Thus, Figure 2.10 shows the Properties dialog box for a 3D model that is part of an assembly. 
The user can see the Instance name field in the Component area, and also the Part Number in the 
Product area. The fields Description, Revision, Definition, etc., are editable by the user, their pur-
pose being a complete definition of the component. In the non-editable field Link to Reference, the 
path to that component (CATPart) on the storage medium is placed.

The Views menu contains the options for viewing the current document (Figure 2.11). Thus, Fit 
All In is used to display the entire document in the working environment on the screen, and Zoom, 
Pan and Rotate to change the perspective, similar to any other CAD program.

These options are very useful for viewing a 3D model from different positions/angles and at a 
different zoom level (approaching/moving away from the workpiece or assembly), in order to choose 
certain points, edges, planes and surfaces that are not seen in the foreground and are behind or 
below other opaque surfaces. Although these options are in the menu and in the View toolbar, some 
can also be activated with the keyboard and mouse (Figure 2.12), through different key combina-
tions and/or buttons.

Thus, if the user presses and holds down the mouse wheel, the Pan operation is performed (the 
view plane moves left-right and up-down). If the Ctrl key on the keyboard is held down and the 

FIGURE 2.10 Establishing the names for a component and for its instance.

FIGURE 2.11 Options to view and navigate the workspace.
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The Render Style option (Figure 2.14) is used to display and visualize the models in workspace 
in one of the few view modes available in the program: Shading, Shading with Edges, Shading 
with Edges without Smooth Edges, Shading with Edges and Hidden Edges, Shading with Material, 
Wireframe and Custom (some of them are displayed in Figure 2.15).

The viewports can be displayed in Perspective or Parallel modes (Figure 2.16). The differences 
in the  matter of visualization between the two representations are noticeable. The CATIA program 
starts by default in Parallel mode, so the user has a correct representation of the part or assembly to 
observe the parallelism or perpendicularity of the edges, planes and faces.

Generally, CAD uses Parallel representation, but the user can also choose Perspective, a visual-
ization closer to reality, useful in the case of interactive presentations of assemblies.

The View menu contains the Lighting option, which can be used to add light to the workspace. 
According to the dialog box in Figure 2.17, three types of lights can be used (Single Light, Two 

FIGURE 2.14 List with the Render Style view modes.

FIGURE 2.15 Pinion part displayed in four view modes.
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Lights and Neon Light). The appearance of the light (Ambient, Diffuse and Specular) is determined 
by the three sliders with their values. The Lighting option is recommended to be used when it is not 
possible to adjust the brightness of the monitor, or when it is not sufficient.

The Hide/Show option allows the user to select any entity (or group of entities) of the model and 
place them in a separate space, where they are not visible, also called ‘no show space’. Those entities 
are ‘hidden’ temporarily or permanently, depending on the future requirements of the document in 
work.

Thus, it may be necessary at some point to hide certain curves, planes, sketches, etc., and then it 
may be useful to display them again.

FIGURE 2.16 Part displayed in Perspective and Parallel modes.

FIGURE 2.17 Different options to add lights in the workspace.
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The Swap visible space option is, in fact, a complement to the previous option, with the role 
of providing the user with access to the space where the hidden entities are placed. As seen in 
Figure 2.18, the hidden space contains numerous curves, planes, sketches and surfaces. The user 
has the possibility to select the features that he wants to be displayed again (the selection can 
also be a multiple one, holding down the Ctrl key during the selection), using the Hide/Show 
option. The hidden space is not intended for work, with all profiles being drawn by default in 
the visible space.

The Insert menu generally contains options and tools that are also present in the toolbars. It is 
recommended to use this menu at least in the first phases of working in CATIA, in the process of 
learning the program, because the icons and the names of the respective instruments are presented. 
Depending on the workbench used, the content of the menu differs.

For example, Figure 2.19 shows an excerpt from the Insert menu when modelling an assembly. 
The user can see the list of assembly constraints (icons and names), compared to the Constraints 
toolbar, specific to the CATIA Assembly Design workbench (shown next to it, on the left). Selecting 
an icon from the toolbar or choosing the same icon with its name from the menu is similar and 
activates a specific constraint.

The Tools menu contains important options related to creating mathematical relations and spe-
cific parameters for the part or assembly in work (Formula), to capturing an image or video sequence 
(Image), recording certain user actions to automate them (Macro), launching additional utilities 

FIGURE 2.18 Different types of features placed in the hidden space.
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included in the program (Utility), displaying/hiding elements of sketches, planes or 3D models 
(Show and Hide), customizing and setting all the working environment parameters (Customize and 
Options), accessing catalogues with standardized components included in the program (Catalog 
Browser), etc.

Choosing the Formula option opens a dialog box (Figure 2.20), and the user has access to the 
parameters of the current document and, also, the possibility to establish relations between them. 
The complex methodology to work with parameters and their related relations is described in detail 
later in this book (Chapters 3 and 4).

The Image option, together with its options (Capture, Album and Video), is used to take screen-
shots of static type (image) or dynamic (video), but also to manage the files thus obtained. Its options 
are useful for presentations and for reproducing the actions performed by the user during a work 
session.

Unlike Image, the Macro option records the user’s actions to keep them in a file. These actions can 
be run at any moment, with the purpose of automating certain work steps. Recording (Figure 2.21) 
takes place after selecting the Start Recording option. The user chooses the file in which to save the 
recorded script, the language used and the name. The Current macro library or document field con-
tains the file to which the automation applies. The language in which the automation is stored can be 
Microsoft VBScript or CATScript, as selected in the Language used field.

The Macro option is used to run the automation. The path and the name of the file containing the 
scripts (the Available macros field) are entered in the dialog box as shown in Figure 2.22.

Saved macros (codes for automatic actions) can be run, edited, renamed, deleted, selected, etc., 
using the buttons on the right. Chapter 5 of this book contains detailed information and samples 
related to automation and scripting.

The Customize option is used to personalize the CATIA working environment. Thus, according 
to the dialog box with the same name in Figure 2.23, in the Start Menu tab, items can be added for 
quick access. From the User Workbenches tab, it is possible to create customized workspaces.

The Toolbars tab presents all the toolbars of the program, and the user has the facility to create 
his own custom toolbars, with tools from different categories.

In addition, an important and useful option is to restore the position and contents of the standard 
toolbars (Restore position and Restore all contents buttons).

FIGURE 2.19 Content of the Insert menu in the Assembly Design workbench.
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FIGURE 2.20 Content of the Formula dialog box showing the names and values of parameters of type 
Length.

FIGURE 2.21 Preparing to record a macro.



15The Working Environment of the CATIA v5 Program

The Commands tab of the Customize dialog box contains the list of menus and their options/
commands, and the user can define the icon for each, and also the shortcut in the keys for quick 
access.

The most important option of the Options tab is related to the language in which the program 
runs: User Interface Language (Figure 2.24).

Also, checking the Tooltips option has the role of familiarizing the user with the names of the 
instruments by displaying a small information box when hovering the mouse over the icon.

The establishment of a fixed position in the interface for a toolbar is done with the option Lock 
Toolbar Position. This is useful when changing the display resolution on the monitor.

All selections and options changes made by the user in the Options tab require CATIA v5 to 
restart to take the effect of the new set-up.

In the Tools menu, there is Options; its use opens a very important and complex dialog box with 
the same name. The user must be aware of the role of certain selections and settings that are useful 
in most stages of working with the CATIA v5 program. Throughout this book, some of the options 
are presented, and some important ones are mentioned below.

The choice of the background colours and of the object manipulation are made from the General 
→ Display category, the Visualization tab (Figure 2.25). The Performance tab sets the 2D and 3D 
accuracy options, the levels of detail and the transparency of the objects/models in progress.

Performance settings are very useful when running the program on poorly equipped computing 
systems (low RAM, older generation microprocessor, integrated video card, etc.). Reducing the 
details will considerably increase the working speed.

The establishment of the measurement and, implicitly, of the working units is done from the cat-
egory General → Parameters and Measure, Units tab (Figure 2.26). In the Knowledge tab, the user 
will check the With value and With formula options so that the parameters defined in the Knowledge 
Advisor workbench are displayed in the specification tree.

The Report Generation tab can specify the format in which CATIA should generate the report 
files, and also what it should contain.

FIGURE 2.22 List of the available macros and the buttons to work with them.
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FIGURE 2.23 Customize dialog box with options to personalize the program.

FIGURE 2.24 Showing the tooltips and choosing the program’s language.
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The Parameters Tolerance tab sets the maximum and minimum tolerances for lengths and 
angles, and the Constraints and Dimensions tab (not shown in Figure 2.26) chooses the colours for 
constraints, when a profile is correctly constrained or not (over-constrained or under-constrained), 
etc.

Also, the constraints, parameters and relations created by the user are displayed in the specifica-
tion tree if their options are checked in the Infrastructure → Part Infrastructure category, Display 
tab (Figure 2.27).

FIGURE 2.25 Choosing the colours for background, selected elements and edges.

FIGURE 2.26 Choosing the measurement units.

FIGURE 2.27 Checking the options to display constraints, parameters and relations in the specification tree.
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Also, in this tab, there is another option, Axis system display size, presented as a slider (Figure 2.28), 
through which the user establishes the dimensions of the orthogonal plane system, regardless of the 
program workbench in which he works.

Numerous options and settings are found and used in the Mechanical Design category for model-
ling parts and assemblies.

Thus, in the case of assemblies, it is necessary to update the assembly constraints. From 
Mechanical Design → Assembly Design, General tab (Figure 2.29), the user chooses how to per-
form this update: in automatic or manual mode. The Manual mode is recommended because the 
user performs various actions with the components of the assembly (translations, rotations, etc.), and 
the update will take place at the end. The Update icon is also visible in the figure.

In the Constraints tab (Figure 2.30), the options for inserting the duplicate components in an 
assembly are chosen, if the components are already constrained. It is recommended to keep the 
default setting, Without the assembly constraints, in the Paste components area (components are 

FIGURE 2.28 Changing the axis system display size.

FIGURE 2.29 Setting the Automatic or Manual update mode.

FIGURE 2.30 Setting how the constraints of an assembly will work.
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Returning to the first variant obtained (Sweep.1 in Figure 3.137), the user will make the intersection 
with the surface Revolute.1 (Figure 3.130) by opening the Intersection Definition dialog box of the 
Intersection tool. The contact surfaces are selected in the First Element and Second Element fields.

Figure 3.139 shows the Intersect.1 curve as the only entity shared by the two surfaces. The user 
observes the positioning of the curve on the Revolute.1 surface. This curve, Intersect.1, will become 
the sweep extrusion path of a profile to obtain the spiral.

The user can hide (context menu, Hide/Show option) several features already used up to this 
stage of the application. Thus, Point.2, Helix.1, Plane.1, Sketch.2 and Sweep.1 are no longer needed 
to be displayed and can switch from visible to hidden space. At any time, these hidden features can 
be viewed (Figure 3.140) by clicking the Swap visible space icon on the View toolbar at the bottom 
of the interface.

Using the Sweep tool, an R3 mm circle is extruded along the Intersect.1 curve, as follows: in 
the Swept Surface Definition dialog box, the user chooses Profile type as Circle (third icon) and 
Subtype: Center and radius. The user does not have to draw the circle on the guide curve (selected 
in the Center curve field), but only to enter the radius value, R3 mm. Thus, the tubular and twisted 
surface, Sweep.2, will be added to the specification tree (Figure 3.141).

As an intermediate check, this surface must have an area of 6559.73 mm2 and the Intersect.1 
curve a length of 348 mm.

The Intersect.1 surface is open at both ends. According to the 2D drawing in Figure 3.125, the 
ends have a hemispherical shape of radius R3 mm. Thus, at each end of the surface, a sphere with 
the same radius value will be inserted, and the Revolute.1 surface can be hidden.

In the GSD workbench, the sphere and the cylinder are primitive surfaces and can be created 
simply by choosing a few parameters: centre, radius, type and delimitation angles for the sphere, 
point, direction, radius and length of the cylinder.

The user should click the Sphere icon on the Surfaces toolbar, and the Sphere Surface Definition 
dialog box opens (Figure 3.142). In the Center field, he chooses the left end of the Intersect.1 curve 
(named Intersect.1\Vertex.1), the axis of the sphere is set by default by the program, and the radius 
of R3 mm is entered. Below, in the Sphere Limitations area, are four fields with angular values, 
available in case the user clicks the icon Create the sphere by specifying the angles. However, a 
sphere feature is inserted in the model by clicking on the adjacent icon, Create the whole sphere.

FIGURE 3.139 Intersecting the two surfaces to obtain their intersection curve – Intersect.1.
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FIGURE 3.140 Swap visible space to display the hidden features: points, curves, planes and surfaces.

FIGURE 3.141 Creation of the twisted surface Sweep.2.

FIGURE 3.142 Creation of a sphere at the left end of surface Sweep.2.
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The Sphere.1 is partially inside the Sweep.2 surface, so an edit of the sphere is needed to fit in 
the end of the Sweep.2 tube. Obviously, from the way they were created, it results that these two 
surfaces intersect after a curve.

The identification of the curve after which the two surfaces touch is done by applying the 
Intersection tool. In the dialog box in Figure 3.143, in the two fields First Element and Second 
Element, the user selects the surfaces Sphere.1 and Sweep.2. If the modelling is correct, the result 
of the intersection is a curve of length 18.85 mm and radius R3 mm and is named Intersect.2. This 
curve is just the edge at the end of the tube.

The sphere must be cut according to this edge to close the end of the Sweep.2 surface. Thus, 
 clicking the Split icon on the Operations toolbar opens the Split Definition dialog box (Figure 3.144).

In the Element to cut field, the user chooses the sphere and, in the Cutting elements list, selects 
the Intersect.2 curve. After the cutting operation, the Split.1 surface results, and in the specification 
tree, the sphere becomes hidden. The dialog box contains the Other side button, so that the sphere 
can be represented, cut and kept on one side or the other of the intersection curve. Figure 3.144 
shows the correct Split.1 surface.

The method of obtaining the intersection curve between the tubular surface Sweep.2 and a 
sphere, Sphere.2, positioned at the right end of the Intersect.1 curve can be similar to the previous 
one: created by the intersection of the two surfaces. The modelling steps present, however, another 
variant, by applying the Boundary tool in the Operations toolbar.

FIGURE 3.143 Intersection between the sphere and the surface Sweep.2.

FIGURE 3.144 The sphere feature was cut with the intersection curve.
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In the Boundary Definition dialog box (Figure 3.145), the user chooses the Point continuity 
option in the Propagation type list and then selects the edge at the end of the tube, named Sweep.2\
Edge.2. The edge becomes from a 3D element, by extraction, a 2D element, the Boundary.1 feature. 
The editing of the sphere with respect to this curve is also done with the help of the Split tool, result-
ing in a closing surface of the tube, named Split.2.

By obtaining this surface, the modelling of the spiral elements ends. In the specification tree in 
Figure 3.146, it is observed that three surfaces are visible and the rest have become hidden. These 
surfaces, Sweep.2, Split.1 and Split.2 are joined using the Join tool in the Operation toolbar to 
become a single surface, Join.1.

In the Join Definition dialog box, the user selects the surfaces and then clicks the Check tangency 
and Check connexity options in the Parameters tab. These options verify if the adjacent surfaces are 
tangent and that there are no small gaps between them. The checks represent an important stage of 
the validation of the Join.1 surface, thus being prepared for the transformation into solid. To comply 
with our modelling, find out if the resulting surface area is 6672.83 mm2.

FIGURE 3.145 The intersection curve is extracted from the end of the Sweep.2 surface.

FIGURE 3.146 Joining surfaces to obtain the first spiral 3D element.
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The user joins the two surfaces (Extrude.2 and CircPattern.2) into one using the Join tool in the 
Operation toolbar, according to the Join Definition dialog box (Figure 3.248).

At this point, the balloon holder contains the Join.1 and Split.1 surfaces (created in Figure 3.243). 
In the Part Design workbench, a thickness of 0.1 mm (First Offset and Second Offset) is added to the 
Split.1 surface, symmetrical to it. The Thick Surface tool from the Surface- Based Features toolbar 
was used (Figure 3.249), and the result is a solid body with a constant thickness of 0.2 mm.

From the Insert menu, a new body (Body.2) is added to the part, and it appears in the specifica-
tion tree on the same level as the PartBody (this is the default body in model tree). The user observes 
that the new body is underlined (Figure 3.250), which means that it is the current (active) body. 
Whatever will be added by the user in the part structure, it will be placed from now on under this 
body. Thus, the surface Join.1 is also transformed into a solid by adding 0.2 mm thickness (Figure 
3.251), similarly to the surface Split.1.

FIGURE 3.246 Extrusion of the spline curve in the direction of the Y axis.

FIGURE 3.247 Multiplication of the previously extruded surface.
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The place of the two surfaces is taken by the ThickSurface.1 and ThickSurface.2 solids, as seen 
in the figure. Surfaces can be hidden because they are no longer needed to be visible in the follow-
ing steps.

Switching between PartBody and Body.2 in terms of editing and/or adding new elements/fea-
tures (which of the two bodies to become current) is done by right- clicking on the selected body, 
and from the context menu, the user chooses the option Define In Work Object. The underline shifts 
from one body to another and then descends to the last feature of the specified body. Figure 3.251 
shows how the solid was underlined when the ThickSurface.2 solid was added to the Body.2. 

FIGURE 3.248 Joining the extruded and multiplied surfaces.

FIGURE 3.249 Adding solid thickness to the resulted surface.

FIGURE 3.250 Inserting a new body in the specification tree of the current 3D model.
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The two bodies (PartBody and Body.2) can be combined using the Boolean operation Union 
Trim found in the Insert ® Boolean Operations menu or in the toolbar with the same name.

By pressing the Union Trim icon, no dialog box is initially displayed; the user is asked in the area 
above the Start button of the Windows operating system (Figure 3.252) which body will be trim 
edited (from which it will be cut). With the selection of the Body.2, the Trim Definition dialog box 
becomes available (Figure 3.253).

The Trim field is already filled in with the Body.2, the with field is filled in automatically with 
PartBody, and the user must select the faces that will be removed when the OK button is pressed. 
Figure 3.253 shows these faces, areas of the Body.2 located inside the PartBody. For the last field 
(Faces to keep), the user can select the surfaces outside the PartBody (as seen in Figures 3.246 
and 3.247) or can leave the field unselected. These selections determine what is cut and what is 
kept. The colours of the selection are different: purple for Faces to remove and blue for Faces to 
keep.

The two bodies are joined into a single one by the Trim.1 feature (Figure 3.254). It is noted that 
it is still possible to edit the Body.2 if the user considers this as necessary.

Between the PartBody and the Body.2, some intersection edges are created, two of them being 
marked in Figure 3.254. These edges belong at this point to the PartBody solid feature.

FIGURE 3.251 Specifying the current body to work on and how to add thickness to a surface.

FIGURE 3.252 Message for the user to select the body to trim.

FIGURE 3.253 Applying the Union Trim tool to cut and join two solid bodies of the support.
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The Angle and Second limit options in the Draft area are checked, and then a value of −1° is 
entered to set the inclination.

The angle value is negative because only through this parameter the inclination can be  controlled. 
Pressing the arrow tip (pointing downwards) causes the extrusion and inclination to be created 
below the XY Plane that contains the profile. The Radius options in the Fillets area must also be 
unchecked because the features contained in the Body.2 do not have fillets.

The specification tree is updated in both cases with the features Pad.1 and Draft.1.
A Union Trim operation is performed between Body.2 and PartBody to combine the two bod-

ies. Thus, in the Trim Definition selection box (Figure 3.338), Body.2 is selected in the Trim field 
and the With field is automatically filled in with PartBody (non-editable field). The Faces to keep 
field contains five side end surfaces and the upper face of the Body.2 (three of these surfaces are 
marked in the figure). The Faces to keep field contains outer surfaces of the PartBody (marked 
also on the figure).

FIGURE 3.335 Selection of faces to be drafted.

FIGURE 3.336 Direction of drafting and a preview on how the faces will be inclined.
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When selecting surfaces (which will be removed and/or kept), they will change colour; for exam-
ple, the removed surfaces become purple and the retained ones become light blue.

Following the union trim of the two bodies, Body.2 is included in the PartBody structure under 
the Trim.1 feature in the specification tree (Figure 3.338). Only the geometry placed inside the 
 button part remains from Body.2.

Due to the way in which the Thickness of the EdgeFillet.1 surface was added (inwards, 
Figure 3.332), the lower edge of the solid exceeds the XY Plane and the inner faces (obtained by 
combining with Body.2), as it is presented in Figure 3.339. The figure shows, for instance, two areas 
(of the four existing ones) in which the difference between the edges is illustrated.

It is, therefore, necessary to cut the edge of the part to be brought into the XY Plane. The fastest 
solution is to use the Split tool of the Surface-Based Features toolbar. In the Split Definition selec-
tion box, the user chooses the XY Plane in the Splitting Element field. The arrow that defines what 
to be kept must be positioned with the tip inwards. Following the elimination of the volume beyond 
the XY Plane, a continuous surface results, a fragment of it is shown in Figure 3.340.

FIGURE 3.338 Selection of faces to keep and faces to remove for the Union Trim operation.

FIGURE 3.337 Creating a drafted pad.
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The Boundary.2 and Boundary.8 edges consist of two lines and a circular arc; all other edges are 
drawn as lines. Each extracted edge has two black dots at the ends, meaning that the elements are 
individual and do not form a connected contour.

The first surface that encloses the cut area is created using the Blend tool. In the Blend Definition 
dialog box (Figure 3.410), in the fields First Curve and Second Curve, the user should select the 
extracted edges Boundary.5 and, respectively, Boundary.1. The selection can be stopped here as 
well, but the surface obtained Blend.1 would not be tangent (as it is correctly presented in the 
2D drawing) to the extracted surfaces Extract.4 and, respectively, Extract.1. Thus, they must be 
selected in the First Support and Second Support fields. In the Basic tab, for a good continuity of 
the cut surfaces, in drop-down lists the user should choose the Tangency option.

At the end of the selections, two red arrows appear on each edge of the surface Blend.1 and they 
control the way the surface is formed. Shorter arrows should point to the newly created surface Blend.1, 
and both long arrows should point in the same direction, inward or outward. The surface Blend.1 is, 
according to Figure 3.410, twisted by 90° and tangent to the support surfaces specified by the user.

The two long edges of the surface are also extracted using the Boundary tool, and the features 
Boundary.9 and Boundary.10 result (Figure 3.411).

The choice of the selected edge propagation option can be No propagation or Tangent continu-
ity. In the case of a more complex selection, the endpoints of an edge to be extracted are set in the 
Limit1 and Limit2 fields.

FIGURE 3.409 Displaying the Extract result.

FIGURE 3.410 Creating a blended surface.
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The cut area will be closed with two patches, as follows: on the upper surface (Extract.3) of 
the part are the extracted edges Boundary.2, Boundary.3, Boundary.4 and Boundary.9, and on 
the bottom surface (Extract.2, Figure 3.408) edges Boundary.6, Boundary.7, Boundary.8 and 
Boundary.10. All these edges represent the contours of the two patches.

For the top edges to form a surface, the Multi-Sections Surface tool in the Surfaces toolbar is 
used.

The selection box in Figure 3.412 contains two main fields: the first (Section) contains the sections 
through which the surface passes, and the second (Guide) contains the guidance curves between 
these sections. These are, in fact, individual curves, which do not intersect, conveniently positioned 
in certain planes of the workspace, and the contour of the created surface will have their exact shape 
as it passes through those planes. From one section to another, the program extrapolates the surface 
to keep it continuous and tangent to other user-selected surfaces.

To create the closing surface in the figure, the user selects the Boundary.4 and Boundary.2 edges 
in the Section column, and then the Extract.3 surface for tangency/continuity.

This means that the program must initiate a Multi-sections Surface.1 starting from the simple 
edge Boundary.4, tangent to the surface Extract.3, to the more complex edge Boundary.4 and 
remaining tangent to the same flat surface Extract.3. The two edges/sections are very different, 
and the task of the program is not simple at all, but it is possible by selecting the two guide 
curves Boundary.3 and Boundary.9. For the first guiding curve, the tangent direction is specified 
as Extract.3.

FIGURE 3.411 Creating two more boundaries from the blended surface.

FIGURE 3.412 Creating the first Multi-Sections Surface feature.
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The projection type (Normal) and the Nearest solution option are checked. The projection of 
the point on the selected edge can be only done in this way, without selecting a certain direction, 
because a line (which will be drawn in the next step) that joins the two points is not along an implicit 
direction of any of the axis X, Y or Z. Only after drawing the line, it can be considered and selected 
as a possible direction. Basically, the point marked in the figure is projected perpendicular to the 
nearest position on the edge.

A line is drawn between the two points using the Point-Point option (Figure 3.430). In that case, 
the line is not on Surface.10 (Figure 3.428) and therefore cannot be used for its editing. The line is 
then projected on this surface, according to Figure 3.431.

The specification tree is updated with the features Project.1 (point on the right edge), Line.1 and 
Project.2. The line and point can be hidden (Hide/Show option in the context menu). The Surface.10 
is divided into two areas using the Split tool: one area is kept (the lower one, Figure 3.432) and the 
other one is removed (the upper one). The appropriate area selection is possible by pressing the 
Other side button in the Split Definition selection box. The removed area is previewed by transpar-
ent representation.

The Multi Output (Split) feature is currently visible in the specification tree because the user 
has not yet selected the area/surface to be kept or the one to be removed, so there are two selec-
tion options (by pressing the Other side button). Once the confirmation of the kept area has been 
received, it is added to the tree as the feature Split.1.

FIGURE 3.429 The projection of a point on an edge.

FIGURE 3.430 Drawing a line between a point and its projection.
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However, there are also cases in which the aim is to keep both resulted surfaces using the Split 
tool, by checking the Keep both sides option. Thus, two features appear in the specification tree, 
Split.1 and Split.2.

Surface.18 (Figure 3.428) is similarly edited using the Split tool, and implementing as Cutting 
elements the Line.2 that joins the ends of curved edges (Figure 3.433).

The line is drawn using the same Point-Point option as before. In the Support field, the user can 
also keep the default selection (Default None) or choose the Surface.18.

Using the Split tool (Split Definition box, Figure 3.434) and selecting Line.2 (Cutting elements) 
as the separating element, the user can edit Surface.18 (Element to cut) to result in the rectangular 
surface Split.2.

Surface.11 must be also removed. It is not possible to simply delete it from the specification tree 
or with the Delete option in the context menu because at least two descending elements (children) 
are connected to this surface: Line.1 and Project.1.

FIGURE 3.431 Projecting a line on a surface.

FIGURE 3.432 Applying the Split tool on the Surface.10.
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Thus, the Sketch.4 is projected onto the surface of the part using the Projection tool in the 
Wireframe toolbar. Figure 3.480 shows the Projection Definition selection box, and from the 
Projection type drop-down list, the user chooses the Along a direction option.

As the projection of the ellipse (selected in the Projected field) will be done in a direction per-
pendicular to the Plane.2, according to the view B in Figure 3.445, the user must choose this plane 
in the Direction field. The surface on which the ellipse is projected is Join.1, selected in the Support 
field. As a result, a 3D curve, Project.1, is created on the surface of the previously generated surface 
part.

Once the projection is done, the ellipse and other features that were involved in creating the sur-
faces model can be hidden, such as Split.1, Split.2, Sketch.2, Circle.1, Extract.1, Extract.2, Plane.1, 
Intersect.1, Intersect.2, Intersect.3, Sketch.3, Plane.2, Sketch.4 and Boundary.1, as defined above.

FIGURE 3.479 Displaying the surface Join.1 and the Sketch.4.

FIGURE 3.480 Creating the project of the Sketch.4 onto the Join.1 surface.
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Along this curve, a circle moves to create a certain tubular surface, which will be extracted 
from the Join.1 surface. There are several ways to get the surface from the top of the part, 
but the fastest one is to use the Sweep tool in the Surfaces toolbar. In the dialog box shown in 
Figure 3.481, the user can observe the Circle icon selected from the Profile type area. The user 
can also choose the Center and radius option from the Subtype drop-down list and then selects 
the Project.1 feature for the guidance curve in the Center curves and Spine fields. The radius of 
the tubular surface is R2 mm according to the 2D drawing in Figure 3.445, section A-A.

The Project.1 curve may seem relatively simple, but obtaining it on the Join.1 surface causes 
some potential tangency problems between successive component segments of the curve. Thus, 
to avoid the error messages obtained by pressing the OK and/or Preview buttons, the user enters 
a value of 3° in the Angular correction field, the other options being checked according to 
Figure 3.481.

The Sweep.1 surface is added to the specification tree, and it is observed that it follows cor-
rectly the shape and curvature of the Join.1 surface. Editing is performed between the two 
surfaces using the Trim tool in the Operations toolbar. In the Trim Definition selection box, the 
user selects the surfaces and then presses the Other side/next element/previous element buttons 
until the correct cutting solution is obtained (Figure 3.482). This way the Sweep.1 surface is 
extracted from Join.1.

The resulting surface, Trim.1, is added to the specification tree and displayed by three orienta-
tions in Figure 3.483. For checking purposes, the area of this surface is 41145.04 mm2. The user 
can transform the Trim.1 surface into a solid body (volume: 647,770.11 mm3) to complete the 
hybrid modelling of this part by using the Close Surface tool in the Volumes toolbar.

The 3D modelling of this gearbox shifter knob is of medium-high complexity, given by the 
initial profiles (Sketch.1 and Sketch.2), the creation of the Sketch.3 and, especially, the under-
standing of the part shape that required performing many working steps with wireframe and 
surface features.

The user can change the dimensions shown in Figure 3.445 to obtain other constructive solutions 
of this gearbox shifter knob.

A modelling version is also presented in the video solution: https://youtu.be/oH47PD9rp-g.

FIGURE 3.481 Creating a swept surface with the implicit profile Circle.
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3.21  MODELLING OF A COMPLEX PLASTIC COVER

In this tutorial, a complex plastic part will be modelled combining Part Design and GSD work-
benches and their tools.

Figure 3.484 shows the 2D drawing of the cover with a sufficient number of views, projections 
and section views. By observing its shape, it could be concluded that the main feature is a revolu-
tion surface with a couple of pockets. Especially interesting are side and back pockets. Also, in the 
section A-A, the constant value of thickness of 1.5 mm tells the user that this is a shell-like structure 
and that the GSD workbench could be a good starting choice to model this part, or Shell tool in Part 
Design may be a good replacement. After learning from this tutorial, the user may try another – his 
own approach.

In the YZ Plane, in the Sketch.1, the user begins to draw a profile consisting of two standard 
lines. By sketching, the user coincidently connects the first point of the first line with the H axis 
and finishes it by left-clicking somewhere inside of the upper right quadrant. The second line 
should be horizontal, and its second point is coincident with the V axis. This profile is open, but 
closed by axes, and for full constraining, some dimensions are needed, as shown in Figure 3.485.  

FIGURE 3.482 Editing the part by applying a Trim operation on selected surfaces.

FIGURE 3.483 Displaying the result of the Trim operation, the final model of the gearbox shifter knob.
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FIGURE 3.545 Creating a Sweep.1 surface feature based on Law.1.

FIGURE 3.546 Creating a Sweep.1 surface feature based on Law.1 – after applying the law.
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FIGURE 3.547 Drawing a Sketch.4 with an open profile in YZ Plane.

FIGURE 3.548 Extruding the Sketch.4 in two directions – Extrude.1.
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This operation was the last one in the modelling process of the citrus juicer. The result is pre-
sented in Figure 3.610.

In the modelling phases of the juicer, the user had to create several geometric sets. In this man-
ner, he kept the 3D model organized in wireframe and shape features, easy to be edited later.

FIGURE 3.608 Converting a surface into a volumetric solid.

FIGURE 3.609 Assembling the part bodies into a single solid.
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3.25  MODELLING OF AN ORNAMENT PANEL

This tutorial explains how to create an ornament panel part. Depending on the dimensions of this 
part, it can be mounted on the facades of buildings with a shading or decorative purpose. For the 
realization of the parameterized model of the panel, the user will apply formulas, geometric sets, 
different operations for copying some features from the specification tree, etc.

Figure 3.611 contains four projections, of which two are orthogonal (one view and one section) 
and two isometric views show the special shape of this part. The dimensions of the elements for 

FIGURE 3.610 The result of the modelling process.

FIGURE 3.611 Representations of the ornament part to be modelled.
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In the same YZ Plane, in the Sketch.4, a spline curve is drawn, next to the surface EdgeFillet.1 
which represents the bellows. The curve should be similar in size to the Sketch.3 line and relatively 
smooth, with no sudden changes in direction and small radii. Outside the Sketch.4, this spline curve 
is extruded and the Extrude.4 surface is obtained in Figure 3.668. The extrusion is similar to that in 
which the Extrude.3 surface was created (Figure 3.667), with the same values of 120 mm.

The user accesses the Wrap Surface icon on the Advanced Surfaces toolbar and opens the Wrap 
Surface Deformation Definition selection box shown in Figure 3.669. The three fields are filled, by 
selection, with existing surfaces in the specification tree, as follows: in the Element to deform field, 
the EdgeFillet.1 surface of the first bellows variant is chosen, Extrude.3 is selected as the reference 
surface, and Extrude.4 is specified as the surface whose shape is to be taken.

FIGURE 3.666 Adding fillets on edges.

FIGURE 3.667 Creating a planar surface inside the first bellows.
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A first solution, corresponding to the 3D option in the Wrap type list, is displayed by pressing 
the Preview button. Both EdgeFillet.1 and Wrap surface.1 are visible, but by pressing the OK but-
ton and confirming the options presented, the EdgeFillet.1 (first bellows) surface is hidden, but 
Extrude.3 remains visible.

FIGURE 3.668 Extrusion of the spline curve from Sketch.4.

FIGURE 3.669 Applying the Wrap Surface tool to obtain the second bellows variant.
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The user can choose one of the variants identified by the program, view the obtained parameters 
and apply their values to the part by pressing the Apply values to parameters button (Figure 4.54).

The application continues with the creation of a rule to edit the part if a certain condition is 
met. The user accesses the Knowledge Advisor workbench over the Start → Knowledgeware menu 
(Figure 4.48).

The user clicks on the Rule icon from the Reactive Features toolbar and opens a first Rule Editor 
information box (Figure 4.60), which states the name of the rule, who created it and on what date, 
and also its positioning in the specification tree.

In the Rule Editor: Rule.1 Active editing box (Figure 4.61), some lines of Visual Basic code are 
entered by the user.

FIGURE 4.60 Creation of a rule to edit the part if a certain condition is met.

FIGURE 4.61 Entering the code sequence in Visual Basic.
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The code sequence compares a parameter with a certain value and, if the condition is fulfilled, 
one of the two computation variants of the other parameters is executed. The syntax if… {….} is used 
to control the distance (initially, it was 30 mm) between the two circles of the Sketch.1 and the verti-
cal axis V (Figure 4.31), which is compared to be less than or equal to (<=) 30 mm. If this condition 
is fulfilled by the respective parameter, then the first variant is executed run.

Otherwise, when the distance is greater (>) than 30 mm, the second variant is run. The two vari-
ants are briefly explained below.

if PartBody\Sketch.1\Offset.3\Offset <=30 mm
{PartBody\Mirror.1\Activity =false
PartBody\EdgeFillet.4\Activity =false
PartBody\Hole.3\HoleLimit.5\Depth =25 mm}
if PartBody\Sketch.1\Offset.3\Offset >30 mm
{PartBody\Mirror.1\Activity =true
PartBody\EdgeFillet.4\Activity =true
PartBody\Hole.3\HoleLimit.5\Depth =50 mm}

the distance is compared with the value of 30 mm
the Mirror.1 feature is disabled
the EdgeFillet.4 feature is disabled
the depth of the Hole.3 becomes 25 mm
the distance is compared with the value of 30 mm
the Mirror.1 feature is enabled
the EdgeFillet.4 feature is enabled
the depth of the Hole.3 becomes 50 mm

In the first variant (Figure 4.62), when the value of the distance is 28 mm, the features Mirror.1 
and EdgeFillet.4 (also marked in Figure 4.43) are deactivated with the help of the Boolean param-
eter Activity of each one. For each disabled feature, the program adds a set of parentheses () next to 
its icon in the specification tree.

By deactivation, the geometries of the two elements disappear from the 3D model of the part. 
Also, the depth of the Hole.3 decreases to 25 mm (the part is no longer pierced). As an example, in 
this variant, the plastic cover can be used for a smaller and simpler connector with a single input (the 
remaining features Pad.3 and Hole.3 in the specification tree).

If the distance between the circles’ centres of the Sketch.1 is greater than 30 mm (31 mm in the 
example in Figure 4.63), the features Mirror.1 and EdgeFillet.4 become active and the depth of the 
hole Hole.3 receives the value of 25 mm (is pierced). In this variant, the part can be mounted as a 
protection cover for a connector with two inputs.

FIGURE 4.62 The cover part represented in the first simpler variant with a single input.
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For these special cases, when parameters are associated with columns, a first parameter-column 
pair will be created, followed by a formula that equals the second parameter with the one involved 
in the association.

Figure 4.75 illustrates a portion of the Formulas dialog box, which shows the parameters b, d2, 
f and P, as well as the manner how they are defined. Thus, the parameters are associated with col-
umns in a design table (DesignTable.1), but another parameter d2 is defined by a formula equal to 
parameter d2 in the table. Similarly, one P parameter is equal to another P parameter in the design 
table. The user should note that the values, set in mm, are equal.

The design table, also called family table, and formulas are present in the specification tree 
(Relations).

Figure 4.76 also shows the current configuration (1) of the design table. If the user wants 
the current part to be modified according to the dimensions set in the Microsoft Excel table  
(Figure 4.72), he will double-click on the Configuration feature to open the Edit Parameter dialog 
box (Figure 4.77).

FIGURE 4.74 Associations between the table columns and the part parameters.

FIGURE 4.75 Parameters set by formulas and design table.
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